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Preface 

About this guide 
This guide describes how to install the product on the supported platform. 

Product Name: UCA Automation 

Product Version: 2.1 

Read this document before installing or using this software. 

Audience 
This document is intended for the solution developers and software development engineers. 

Software versions 
The term UNIX is used as a generic reference to the operating system, unless otherwise specified. 

The software versions referred to in this document are as follows. 

Table 1: Software versions 

Product version Supported operating systems 
UCA Automation 2.1 Linux Red Hat Enterprise Linux Server release 6.4 

 

Typographical conventions 
Fixed width 
text 

It is used for filenames and their contents, computer inputs or outputs, 
program codes, and so on. 

Italic text It is used for labels, parameters, emphasized text, and replaceable text, 
citations and references 

Bold text It is used to indicate navigation options in the interfaces; for example, the 
text appearing in buttons and menu items. User interface controls, window 
titles, generic emphasis 

<angle brackets> Indicates generic variable names that must be substituted by real values or 
strings. 

Associated documents 
The following documents contain useful reference information: 

• HPE UCA for Event Based Correlation Installation Guide 

• HPE UCA for Event Based Correlation Topology Extension Guide 
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• HPE UCA for Event Based Correlation Value Pack Development Guide 

• Deployment Manager (HPE SA) Guide 

• NOM Installation and Configuration Guide 

• UCA HPE SA CA Main Release Guide 

• UCA Autoconsole CA Main Release Guide 

• NOM UCA EBC Channel Adapter Installation Guide 

• NOM TEMIP Channel Adapter Installation Guide 

• UMB Installation and Configuration guide   

Support 
Please visit our HPE Software Support Online Web site at softwaresupport.hpe.com for contact 
information, and details about HPE Software products, services, and support. 

The Software support area of the Software Web site includes the following:  
• Downloadable documentation.  
• Troubleshooting information.  
• Patches and updates.  
• Problem reporting.  
• Training information.  
• Support program information. 

https://softwaresupport.hpe.com/
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Chapter 1  
Introduction 

This guide describes the installation procedure for the UCA Automation solution. 

1.1 Local install descriptors 
The following locations are used to define install locations throughout this guide. 

Table 2: Local install descriptors 

Descriptor Description 
${ACTIVATOR_OPT} The base install directory of Service Activator. The UNIX® location 

is /opt/OV/ServiceActivator. 
${SOLUTION_ETC} 

The etc directory of the HPE SA value pack solution. 

The default value for UCA Solution is 
/opt/OV/ServiceActivator/solutions/UCA/etc 

${UCA_EBC_HOME} 
The root directory of UCA-EBC.  

The default value is /opt/UCA-EBC. 
${UCA_EBC_DATA} 

The data directory of UCA-EBC.  

The default value is /var/opt/UCA-EBC. 
${UCA_EBC_INSTANCES} 

This directory might contain multiple instances of UCA-EBC where 
the value packs are deployed.  

The path refers to 
${UCA_EBC_DATA}/instances/default. 

${NOM_INSTANCE} NOM Container instance directory 
/var/opt/openmediation-
72/containers/<instance-#> 

${UCA_AUTO_HOME} 
The root directory of UCA Automation 

The default value is /opt/UCA_UCAAutomation 
${SAUMB_INSTANCE} The data directory for HPE Service Activator UMB adapter 

/var/opt/service-activator-umb-adapter/ 
${UMB_DATA} 

The data directory of UMB 

The default value is /var/opt/UMB 
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Chapter 2  
System requirements 

2.1 Server platforms 
• UCA-EBC 3.3 and latest Patches 

• HPE SA V70-1A 

• NOM 7.2  

• UMB 1.0 and latest Patches 

Refer above products server compatility matrix for the supported operating systems.  

2.2 Hardware requirements 
• X86-64 based system 

• At least 4 GB of memory 

• The database system requires a space for an Oracle 12c or an Enterprise Database Postgres 
9.2 database instance of at least 4 GB for the product data. The database requirements is in 
line with HPSA 70-1A recommendations 

2.3 Software requirements 

2.3.1 HPE UCA-EBC 
• UCA for Event Based Correlation Server V3.3 and the latest patches (Server patch 00002 is 

mandatory).  

• UCA for Event Based Correlation Topology Extension. 

2.3.1.1  Configure HPE UCA EBC 
• Edit the ${UCA_EBC_INSTANCES}/conf/uca-ebc.properties file to add the 

following configuration to integrate the UCA Automation UI login with UCA EBC. 

UCA_Automation_Foundation_UCA-V2.1-1A-UCAAutomation-webapp-
parameters=username=${user},userrole=${role} 

• Update the ${UCA_EBC_INSTANCES}/conf/GraphDisplayProfiles.xml file 
with the following configuration. 
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<Profile name="ucaatm" displayedName="Decision Tree View" defaultProfile="false" 
POICategories="Health"> 
 <Nodes> 
  <Node attributeName="ID" attributeValue="0"> 
   <Icon> 
    <MainIcon>images/world.jpg</MainIcon> 
   </Icon> 
   <Text> 
    <Emphasis>plain</Emphasis> 
    <DisplayedName>[${ID}] ${name}</DisplayedName> 
   </Text> 
   <GetNeighbors automatic="true" level="999"> 
    <Queries> 
     <Query><![CDATA[START startNode = node({nodeID})  
MATCH (startNode)<-[relationship]->(endNode) WHERE ID(startNode)>0 and ID(endNode)>0 
RETURN startNode, relationship, endNode;]]></Query> 
    </Queries> 
   </GetNeighbors> 
  </Node> 
  <Node attributeName="name" attributeValue="UCAAutomation"> 
   <Icon> 
    <MainIcon>images/round.jpg</MainIcon> 
   </Icon> 
   <Text> 
    <Emphasis>plain</Emphasis> 
    <DisplayedName>[${ID}] ${name}</DisplayedName> 
   </Text> 
   <GetNeighbors automatic="true" level="999"> 
    <Queries> 
     <Query><![CDATA[START startNode = node({nodeID})  
MATCH (startNode)<-[relationship]->(endNode) WHERE ID(startNode)>0 and ID(endNode)>0 
RETURN startNode, relationship, endNode;]]></Query> 
    </Queries> 
   </GetNeighbors> 
  </Node> 
  <Node attributeName="name" attributeValue="MobileServices"> 
   <Icon> 
    <MainIcon>images/round.jpg</MainIcon> 
   </Icon> 
   <Text> 
    <Emphasis>plain</Emphasis> 
    <DisplayedName>[${ID}] ${name}</DisplayedName> 
   </Text> 
   <GetNeighbors automatic="true" level="999"> 
    <Queries> 
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     <Query><![CDATA[START startNode = node({nodeID})  
MATCH (startNode)<-[relationship]->(endNode) WHERE ID(startNode)>0 and ID(endNode)>0  
RETURN startNode, relationship, endNode;]]></Query> 
    </Queries> 
   </GetNeighbors> 
  </Node> 
  <Node attributeName="dispatchType" attributeValue="HPSA"> 
   <Icon> 
    <MainIcon>images/round.jpg</MainIcon> 
    <Decorations attributeName="state"> 
     <Decoration 
attributeValue="Waiting_Operator">images/warningLarge.png</Decoration> 
     <Decoration 
attributeValue="Ok">images/ok.png</Decoration> 
     <Decoration attributeValue="Failure">images/error-
icon.png</Decoration> 
    </Decorations> 
   </Icon> 
   <Text> 
    <Color>153 0 0</Color> 
    <Font>Courier New</Font> 
    <Size>10</Size> 
    <Emphasis>plain</Emphasis> 
    <DisplayedName>[${ID}] ${name}</DisplayedName> 
   </Text> 
   <GetNeighbors automatic="true" level="20"> 
    <Queries> 
     <Query><![CDATA[START startNode = node({nodeID})  
MATCH (startNode)<-[relationship]->(endNode) WHERE ID(startNode)>0 and ID(endNode)>0 
RETURN startNode, relationship, endNode;]]></Query> 
    </Queries> 
   </GetNeighbors> 
  </Node> 
  <Node attributeName="dispatchType" attributeValue="Trouble Ticket"> 
   <Icon> 
    <MainIcon>images/round.jpg</MainIcon> 
    <Decorations attributeName="state"> 
     <Decoration 
attributeValue="Waiting_Operator">images/warningLarge.png</Decoration> 
     <Decoration 
attributeValue="Ok">images/ok.png</Decoration> 
     <Decoration attributeValue="Failure">images/error-
icon.png</Decoration> 
    </Decorations> 
   </Icon> 
   <Text> 
    <Color>153 0 0</Color> 
    <Font>Courier New</Font> 
    <Size>10</Size> 
    <Emphasis>plain</Emphasis> 



 
System requirements 11 

    <DisplayedName>[${ID}] ${name}</DisplayedName> 
   </Text> 
   <GetNeighbors automatic="true" level="20"> 
    <Queries> 
     <Query><![CDATA[START startNode = node({nodeID})  
MATCH (startNode)<-[relationship]->(endNode) WHERE ID(startNode)>0 and ID(endNode)>0 
RETURN startNode, relationship, endNode;]]></Query> 
    </Queries> 
   </GetNeighbors> 
  </Node> 
  <Node attributeName="dispatchType" attributeValue="Alarm"> 
   <Icon> 
    <MainIcon>images/round.jpg</MainIcon> 
    <Decorations attributeName="state"> 
     <Decoration 
attributeValue="Waiting_Operator">images/warningLarge.png</Decoration> 
     <Decoration 
attributeValue="Ok">images/ok.png</Decoration> 
     <Decoration attributeValue="Failure">images/error-
icon.png</Decoration> 
    </Decorations> 
   </Icon> 
   <Text> 
    <Color>153 0 0</Color> 
    <Font>Courier New</Font> 
    <Size>10</Size> 
    <Emphasis>plain</Emphasis> 
    <DisplayedName>[${ID}] ${name}</DisplayedName> 
   </Text> 
   <GetNeighbors automatic="true" level="20"> 
    <Queries> 
     <Query><![CDATA[START startNode = node({nodeID})  
MATCH (startNode)<-[relationship]->(endNode) WHERE ID(startNode)>0 and ID(endNode)>0 
RETURN startNode, relationship, endNode;]]></Query> 
    </Queries> 
   </GetNeighbors> 
  </Node> 
 </Nodes> 
 <Relationships> 
  <Relationship attributeName="Type" attributeValue="hasport"> 
   <LineType>dash</LineType> 
   <SourceHead>circle</SourceHead> 
   <TargetHead>arrow</TargetHead> 
   <DisplayedName>${Type}</DisplayedName> 
  </Relationship> 
  <Relationship attributeName="Type" attributeValue="LINK"> 
   <LineType>line</LineType> 
   <SourceHead>arrow</SourceHead> 
   <TargetHead>arrow</TargetHead> 
   <DisplayedName>${Type}</DisplayedName> 
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   <Colors attributeName="state" default="0 255 0"> 
    <Color attributeValue="Down">255 0 0</Color> 
    <Color attributeValue="Up">0 255 0</Color> 
   </Colors> 
  </Relationship> 
 </Relationships> 
</Profile> 

2.3.1.2 NOM Configuration 
• To use NOM the following property must be set in 

${UCA_EBC_INSTANCES}/conf/uca-ebc.properties file.  

use.new.generation.adapter=false 

• Add following in ${UCA_EBC_INSTANCES}/conf/ActionRegistry.xml file 

<MediationValuePack MvpName="temip" MvpVersion="2.2.0" 
 url="http://localhost:26700/uca/mediation/action/ActionService?WSDL" 
 brokerURL="failover://tcp://localhost:10000"> 
 ... 
 ... 
 <Action actionReference="HPSA_diagnosticTask_localhost"> 
  <ServiceName>diagnosticTask</ServiceName> 
  <NmsName>hpsa</NmsName> 
 </Action> 
</MediationValuePack> 

• Comment out UMB Actions in UCA_EBC_INSTANCES}/conf/ActionRegistry.xml 

file. 

<!--UMBActions> 
 <UMBAction actionReference="TeMIP_AO_Directives_localhost" targetName="TeMIP" 
targetActionName="AOAction"/> 
 <UMBAction actionReference="TeMIP_TT_Directives_localhost" targetName="TeMIP" 
targetActionName="TTAction"/> 
 <UMBAction actionReference="TeMIP_Passthrough_Directives_localhost" 
targetName="TeMIP" targetActionName="PassthroughAction"/> 
</UMBActions--> 
 

2.3.1.3 UMB configuration 
• To use Unified Mediation Bus the following property must be set in 

{UCA_EBC_INSTANCES}/conf/uca-ebc.properties file.  

use.new.generation.adapter=true 
received.events.logger.enabled = true 

• Uncomment UMB Actions in 

${UCA_EBC_INSTANCES}/conf/ActionRegistry.xml and comment mediation 
flow elements. 

<UMBActions> 
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 <UMBAction actionReference="TeMIP_AO_Directives_localhost" targetName="TeMIP" 
targetActionName="AOAction"/> 
 <UMBAction actionReference="TeMIP_TT_Directives_localhost" targetName="TeMIP" 
targetActionName="TTAction"/> 
 <UMBAction actionReference="TeMIP_Passthrough_Directives_localhost" 
targetName="TeMIP" targetActionName="PassthroughAction"/> 
</UMBActions> 

• Add following in ${UCA_EBC_INSTANCES}/conf/ActionRegistry.xml file 

<UMBActions> 
 ... 
 ... 
 <UMBAction actionReference="HPSA_diagnosticTask_localhost" targetName="service-
activator-umb-adapter" targetActionName="diagnosticTask" /> 
</UMBActions> 

• In ${UCA_EBC_INSTANCES}/conf/uca-ebc-log4j.xml, add the following 

<!--logger name="UCAEBC.AdapterCollectedEvents" additivity="false"> 
           <level value="INFO" /> 
           <appender-ref ref="ASYNCINCOMINGMSG" /> 
    </logger--> 
    <logger name="UCAEBC.AdapterCollectedEvents" additivity="false">  
           <level value="INFO" />  
           <appender-ref ref="UMBASYNCINCOMINGMSG" />  
    </logger> 

• In  ${UCA_EBC_INSTANCES}/conf/hazelcast.xml, make appropriate changes to 
connect to Hazelcast. Please refer UCA-EBC Administration, Configuration and 
Troubleshooting Guide for more details. 

<management-center enabled="false">http://localhost:8080/mancenter</management-center> 

 

<network> 
 ... 
 <join> 
  … 
  … 
  <tcp-ip enabled="true"> 
   <interface>localhost</interface> 
          </tcp-ip> 
 </join> 
</network> 

• Restart UCA-EBC server. 

Please refer to Unified Correlation Analyzer for Event Based Correlation Administration,Configuration 
and Troubleshooting Guide for more information on how to configure the ActionRegistry.xml file if 
NMS is not TeMIP 



 
System requirements 14 

2.3.2 HPE Service Activator 
• HPE Service Activator version 7.0 - V70-1A and the latest patches 

• Oracle 12c or Postgres Plus Advanced Server 9.2 or later. The database can be installed on the 
same server or can be accessed remotely (but it must be located in the same sub network). You 
can also use an existing database that is used by another application. In that case, you need to 
create a new database user (if Oracle is used) or a new database instance (if Postgres Plus 
Advanced Server is used) for the exclusive use by Service Activator and UCA Automation. 

• Ensure that PPAS is configured to run in the “Oracle” mode during its installation 

2.3.3 NOM 
• OSS Open Mediation V7.2 and latest patches 

# rpm -qa| grep ngossopenmediation 
ngossopenmediation-7.2.0-RHEL5.noarch 
# nom_admin --list-ip-in-container 
DEPLOYED        nom-basic-smx-components 
DEPLOYED        smx-basic-components 

• UCA for Event Based Correlation Channel Adapter V3.3 

# rpm -qa | grep UCA-EBCCA 
UCA-EBCCA-V3.3-0B.noarch 
# nom_admin --list-ip-in-container| grep uca-ebc-ca 
DEPLOYED        uca-ebc-ca-3.3  

• The TeMIP Channel Adapter: if your solution involves TeMIP  

 
# rpm -qa | grep -i ngosstemip-ca 
ngosstemip-ca-2.2.0-RHEL5.x86_64 
# nom_admin --list-ip-in-container| grep temip-ca-22 
DEPLOYED        temip-ca-22 

2.3.4 Configure TeMIP Channel Adapter for UCA Automation 

 
NOTE: This configuration is optional 

• Validate the TeMIP configuration in the file. 

• Edit the ${NOM_INSTANCE}/ips/temip-ca-
22/etc/conf/TeMIP_configuration.dynamic.xml file.  

• For example, if the TeMIP Director is configured on the ossdemo1.ind.hpe.com host, the file 
should contain the following configuration: 

<TeMIPDirectorEntity>.temip.ossdemo1_temip</TeMIPDirectorEntity> 

• Edit the ${NOM_INSTANCE}/ips/temip-ca-
22/etc/conf/TeMIP_configuration.dynamic.xml to add the custom attributes 
required for UCA Automation within the tags. 

 

<CustomAttributes> 
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… 
… 
</CustomAttributes> 
<CustomAttribute> 
  <Attribute>Action</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Actionidlist</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Actionstatus</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Evp</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Evpscenario</Attribute> 
  <Datatype>XmlString</Datatype> 
 </CustomAttribute> 
  
<CustomAttribute> 
  <Attribute>Outputparameters</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Problem</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Rawresult</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Resourceinstance</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Serviceinstance</Attribute> 
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  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Taskid</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Initiator</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Originatingfms</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Outage Flag</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 

 

• Edit the ${NOM_INSTANCE}/ips/temip-ca-22/etc/actions.to-
temip.ao.request.xslt file and add the custom attributes required for UCA Automation in 
the <!-Specific output nodes> tag. 

<!-- Specific output nodes --> 
<xsl:template name="Action"> 
   <xsl:call-template name="simple_node"> 
      <xsl:with-param name="input_node" select="command/entry[key='Action']" /> 
   <xsl:with-param name="output_node_name" select='"Action"' /> 
       </xsl:call-template> 
    </xsl:template> 
    <xsl:template name="Actionidlist"> 
      <xsl:call-template name="simple_node"> 
        <xsl:with-param name="input_node" select="command/entry[key='Actionidlist']" /> 
        <xsl:with-param name="output_node_name" select='"Actionidlist"' /> 
      </xsl:call-template> 
    </xsl:template> 
    <xsl:template name="Actionstatus"> 
      <xsl:call-template name="simple_node"> 
        <xsl:with-param name="input_node" select="command/entry[key='Actionstatus']" /> 
        <xsl:with-param name="output_node_name" select='"Actionstatus"' /> 
       </xsl:call-template> 
     </xsl:template> 
     <xsl:template name="Evp"> 
       <xsl:call-template name="simple_node"> 
         <xsl:with-param name="input_node" select="command/entry[key='Evp']" /> 
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         <xsl:with-param name="output_node_name" select='"Evp"' /> 
         </xsl:call-template> 
       </xsl:template> 
       <xsl:template name="Evpscenario"> 
         <xsl:call-template name="simple_node"> 
            <xsl:with-param name="input_node" select="command/entry[key='Evpscenario']" /> 
         <xsl:with-param name="output_node_name" select='"Evpscenario"' /> 
        </xsl:call-template> 
       </xsl:template> 
       <xsl:template name="Outputparameters"> 
          <xsl:call-template name="simple_node"> 
            <xsl:with-param name="input_node" select="command/entry[key='Outputparameters']" /> 
            <xsl:with-param name="output_node_name" select='"Outputparameters"' /> 
           </xsl:call-template> 
        </xsl:template> 
        <xsl:template name="Problem"> 
           <xsl:call-template name="simple_node"> 
             <xsl:with-param name="input_node" select="command/entry[key='Problem']" /> 
             <xsl:with-param name="output_node_name" select='"Problem"' /> 
             </xsl:call-template> 
        </xsl:template> 
      <xsl:template name="Rawresult"> 
        <xsl:call-template name="simple_node"> 
          <xsl:with-param name="input_node" select="command/entry[key='Rawresult']" /> 
          <xsl:with-param name="output_node_name" select='"Rawresult"' /> 
        </xsl:call-template> 
        </xsl:template> 
        <xsl:template name="Resourceinstance"> 
        <xsl:call-template name="simple_node"> 
           <xsl:with-param name="input_node" select="command/entry[key='Resourceinstance']" /> 
           <xsl:with-param name="output_node_name" select='"Resourceinstance"' /> 
          </xsl:call-template> 
       </xsl:template> 
       <xsl:template name="Serviceinstance"> 
       <xsl:call-template name="simple_node"> 
       <xsl:with-param name="input_node" select="command/entry[key='Serviceinstance']" /> 
       <xsl:with-param name="output_node_name" select='"Serviceinstance"' /> 
      </xsl:call-template> 
     </xsl:template> 
    <xsl:template name="Taskid"> 
      <xsl:call-template name="simple_node"> 
      <xsl:with-param name="input_node" select="command/entry[key='Taskid']" /> 
      <xsl:with-param name="output_node_name" select='"Taskid"' /> 
      </xsl:call-template> 
     </xsl:template> 
    <xsl:template name="Initiator"> 
      <xsl:call-template name="simple_node"> 
      <xsl:with-param name="input_node" select="command/entry[key='Initiator']" /> 
      <xsl:with-param name="output_node_name" select='"Initiator"' /> 
     </xsl:call-template> 
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     </xsl:template> 
     <xsl:template name="Originatingfms"> 
        <xsl:call-template name="simple_node"> 
        <xsl:with-param name="input_node" select="command/entry[key='Originatingfms']" /> 
        <xsl:with-param name="output_node_name" select='"Originatingfms"' /> 
      </xsl:call-template> 
    </xsl:template> 
 <xsl:template name="Outage_Flag"> 
  <xsl:call-template name="simple_node"> 
   <xsl:with-param name="input_node" 
select="command/entry[key='Outage_Flag']" /> 
   <xsl:with-param name="output_node_name" select='"Outage_Flag"' /> 
  </xsl:call-template> 
 </xsl:template> 

• Add the following entry under the <!-- CREATE: --> tag. 

<!-- **************** --> 
<xsl:if test="($request_type='Create')"> 
 <oper:Arguments> 
  <xsl:variable name="of_type_timestamp" select="'Event_Time'"/> 
  <xsl:variable name="of_type_simple_node" select="('Probable_Cause', 
   'Security_Alarm_Cause',  
   'Backed_Up_Status',  
   'Trend_Indication',  
   'Notification_Identifier', 
   'Additional_Text',  
   'Alarm_Object_Operator_Note', 
   'Number_Of_Outstanding_Alarms', 
   'User_Identifier',  
   'User_Text',  
   'Pb', 
   'Action', 
           'Actionidlist', 
           'Actionstatus', 
           'Evp', 
          'Evpscenario', 
           'Outputparameters', 
           'Problem', 
           'Rawresult', 
           'Resourceinstance', 
           'Serviceinstance', 
           'Taskid', 
           'Originatingfms', 
           'Initiator')"/> 

• Add the following entry under the <!-- Service_Provider is not yet 
implemented --> tag. 

<xsl:call-template name="Alarm_Object_Operator_Note" /> 
<xsl:call-template name="User_Identifier" /> 
<xsl:call-template name="User_Text" /> 
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<xsl:call-template name="Parents_Set" /> 
<xsl:call-template name="Children_Set" /> 
<xsl:call-template name="Pb" /> 
<xsl:call-template name="Action" /> 
<xsl:call-template name="Actionidlist" /> 
<xsl:call-template name="Actionstatus" /> 
<xsl:call-template name="Evp" /> 
<xsl:call-template name="Evpscenario" /> 
<xsl:call-template name="Outputparameters" /> 
<xsl:call-template name="Problem" /> 
<xsl:call-template name="Rawresult" /> 
<xsl:call-template name="Resourceinstance" /> 
<xsl:call-template name="Serviceinstance" /> 
<xsl:call-template name="Taskid" /> 
<xsl:call-template name="Originatingfms" /> 
<xsl:call-template name="Initiator" /> 

• Add the following entry under <!-- SET: 82 items of Attribute List --> 

<xsl:variable name="of_type_simple_node" select="(' Acknowledgement_User_Identifier',. . .,  
'Pb',  

               'Parents', 
               'Children',  
               'Action', 
 'Actionidlist', 
 'Actionstatus', 
 'Evp', 
 'Evpscenario', 
 'Outputparameters', 
 'Problem', 
 'Rawresult', 
 'Resourceinstance', 
 'Serviceinstance', 
 'Taskid', 
 'Initiator', 
 'Originatingfms')"/> 

• Redeploy the TeMIP channel adapter. 

#nom_admin --undeploy-ip-in-container temip-ca-22 
#nom_admin --deploy-ip-in-container temip-ca-22 

2.3.5 UMB 
To install and deploy the Unified Mediation Bus, follow the instructions in the Unified Mediation Bus 
installation and Configuration guide.  
 
Follow the instructions in the guide to stop/start Kafka, Zookeeper and Runtime package. 

2.3.6 UCA EBC UMB Adapter 
The UCA EBC UMB Adapter is packaged and installed as part of UCA EBC 3.3 server installation. 
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2.3.7 Configure TeMIP UMB Adapter 

 
NOTE: This configuration is optional. 

Edit the adapter.properties file in ${UMB_DATA}/temip-adapter/conf directory, replace 
“localhost” with IP address of the the Kafka broker host 

producer.metadata.broker.list=localhost:9092 
producer.request.required.acks=1 
 
consumer.zookeeper.connect=localhost:2181 
consumer.zookeeper.session.timeout.ms=6000 
consumer.zookeeper.sync.time.ms=203 
consumer.auto.commit.interval.ms=1000 
consumer.auto.offset.reset=smallest 
 
#################################### 
# TeMIP Collector Properties 
#################################### 
 
# size of the raw event collection queue used to store raw inevent during resynchronization 
uca.collection.rawCollectionQueueSize=10000 

Edit hazelcast.xml file in  ${UMB_DATA}/temip-adapter/conf directory and make appropriate 
changes to connect to Hazelcast. Please refer UCA-EBC Administration, Configuration and 
Troubleshooting Guide for more details 

 

 <management-center enabled="false">http://localhost:8080/mancenter</management-center> 

 

<network> 
 ... 
 <join> 
  ... 
  … 
  <tcp-ip enabled="true"> 
   <interface>localhost</interface> 
          </tcp-ip> 
 </join> 
</network> 

Edit TeMIP_configuration.xml in ${UMB_DATA}/temip-adapter/conf directory, replace 
“localhost” with TeMIP host IP Address 

<MachineName>localhost</MachineName> 

• Validate the TeMIP configuration in the file. 

• Edit the ${UMB_DATA}/temip-adapter/conf/TeMIP_configuration.xml file.  

• For example, if the TeMIP Director is configured on the ossdemo1.ind.hpe.com host, the file 
should contain the following configuration: 

<TeMIPDirectorEntity>.temip.ossdemo1_temip</TeMIPDirectorEntity> 
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• Edit the ${UMB_DATA}/temip-adapter/conf/TeMIP_configuration.xml to add 
the custom attributes required for UCA Automation within the tags. 

<CustomAttributes> 
………………… 
</CustomAttributes> 
<CustomAttribute> 
  <Attribute>Action</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Actionidlist</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Actionstatus</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Evp</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Evpscenario</Attribute> 
  <Datatype>XmlString</Datatype> 
 </CustomAttribute> 
  
<CustomAttribute> 
  <Attribute>Outputparameters</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Problem</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Rawresult</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Resourceinstance</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 



 
System requirements 22 

<CustomAttribute> 
  <Attribute>Serviceinstance</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Taskid</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Initiator</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Originatingfms</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 
 
<CustomAttribute> 
  <Attribute>Outage Flag</Attribute> 
  <Datatype>XmlString</Datatype> 
</CustomAttribute> 

• Edit the ${UMB_DATA}/temip-adapter/conf/AdapterConfiguration.xml file. 
Define a flow for UCA Automation with the following parameters 

<flowServices> 
 … 
 … 
    <flow name="UCAAutomationTeMIPFlow" type="Dynamic" 
collectorClass="com.hp.umb.adapter.temip.TeMIPCollector"> 
  <parameters> 
                  <parameter key="configurationFile" 
defaultValue="TeMIP_configuration.xml"/> 
                    <parameter key="operationContext" occurs="many"/> 
         </parameters> 
        </flow> 
</flowServices> 

2.3.8 JAVA 
Java JRE/JDK 8 (1.8.0.XX) 

 IMPORTANT: Service Activator UMB adapter works on Java JRE/JDK 1.8 only. 
It is mandatory to install UCA EBC on Java 1.8 

2.3.9 Configure TeMIP 6.2L 

 
NOTE: This configuration is optional 
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When TeMIP 6.2L is used as NMS, perform the following: 

• Install and configure TeMIPV62L with the latest available patches. 

• For more details, refer to the TeMIP Installation Guide for Linux. 

• Install and configure TeMIP Web Services with the latest patches. 

• For more details, refer to the TeMIP WebServices Installation and 
Administration Guide.  

• Set TeMIP Web Services Security level to none. 

• Run the following command to update the TeMIP dictionary with custom attributes required for 
UCA EBC 3.3. 

/usr/opt/temip/bin/temip_ah_user_defined_attr -project TPD 

2.3.10 Configure TeMIP when used as NMS 

 
NOTE: This configuration is optional 

 When TeMIP is used as an NMS, configure TeMIP using the following procedure. 

• Enter the TeMIP management and run the following commands. 

$ manage 
TeMIP Framework (V6.2.0) 

 

TeMIP> create domain uca_dom  
Domain tfrsol1_ns:.uca_dom 
On director: tfrsol1_ns:.temip.tfrsol1_director 
AT Mon 11 Mar 2013 06:54:49 
 
Entity successfully created. 

 

TeMIP> create oper uca_network assoc domain uca_dom 
OPERATION_CONTEXT tfrsol1_ns:.uca_network 
On director: tfrsol1_ns:.temip.tfrsol1_director 
AT Mon 11 Mar 2013 06:55:29 
 
Operation Context successfully created 

 

TeMIP> create oper uca_pbalarm assoc domain uca_dom 
OPERATION_CONTEXT tfrsol1_ns:.uca_pbalarm 
On director: tfrsol1_ns:.temip.tfrsol1_director 
AT Mon 11 Mar 2013 06:56:07 
 
Operation Context successfully created 

 

TeMIP> register oper uca_network 
OPERATION_CONTEXT tfrsol1_ns:.uca_network 
On director: tfrsol1_ns:.temip.tfrsol1_director 
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AT Mon 11 Mar 2013 06:56:22 
 
Registration successful. 

 

TeMIP> register oper uca_pbalarm 
OPERATION_CONTEXT tfrsol1_ns:.uca_pbalarm 
On director: tfrsol1_ns:.temip.tfrsol1_director 
AT Mon 11 Mar 2013 06:56:36 
 
Registration successful. 

   
 

TeMIP> set oper uca_network Emit Aggregate Event = true 
  OPERATION_CONTEXT tfrsol1_ns:.uca_network 
  On director: tfrsol1_ns:.temip.tfrsol1_director 
  AT Mon 11 Mar 2013 06:57:47 Characteristics 
  Modification(s) completed successfully. 

 
 

TeMIP> set oper uca_pbalarm Emit Aggregate Event = true 
  OPERATION_CONTEXT tfrsol1_ns:.uca_pbalarm 
  On director: tfrsol1_ns:.temip.tfrsol1_director 
  AT Mon 11 Mar 2013 06:58:47 Characteristics 
  Modification(s) completed successfully. 

2.4 Web client 
• Mozilla Firefox 36 

• Google Chrome 41 

• Microsoft Internet Explorer 8 or later 
The UCA for EBC User Interface works better with Internet Explorer 8.0 
Internet Explorer 9, 10 and 11 must be set with the “Browser Mode” set to “Internet Explorer 8 
Compatibility view” mode. 
Internet Explorer compatibility mode can be set from the following menu: 
Tools -> F12 Developer Tools -> Browser Mode 
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Chapter 3  
UCA Automation solution pack 

This chapter includes the procedures to install the following components: 

• UCA Automation Solution Pack 

• HPE SA Foundation Value Pack 

• UCA EBC Foundation Value Pack 

• UCA Automation UI 

• NOM Channel Adapters 

3.1 Installing UCA Automation solution 
The UCA Automation solution is delivered as a tar file named: 

uca-automation-kit-2.1-linux.tar 

To install the package, perform the following operations: 

1. As root user, untar the archive in a temporary local directory (For example: /tmp): 

# cd /tmp 
# tar -xvf uca-automation-kit-2.1-linux.tar 

2. Run the installation script. 

Depending on whether you wish to install the UCA Automation at the default location, i.e. 
/opt/UCA_UCAAutomation, or an alternate location, run either of the following commands to 
execute the installation script. 

To install UCA Automation at the default location (in /opt/UCA_Automation directory), please 
execute the following command as root user: 

# install-uca-automation.sh 

• To install UCA Automation at an alternate location of your choosing, please execute the following 
command as root user: 

# install-uca-automation.sh –r <root directory> 

• If root directory is not specified, the default root directory for UCA Automation is 
/opt/UCA_Automation. 

• Before running the installation script ensure that UCA_EBC_HOME is set to UCA-EBC Home 
Directory 

 

 
NOTE: Installing UCA Automation as non-root user (Linux ony): 

 

• For some very specific needs UCA Automation package can be installed by a non-root user. This 
feature is available for Linux only. 
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• When installing UCA Automation as non-root user, the following limitations must be understood 
and acknowledged: 

− The system RPM database is not accessible by a non-root user. As a consequence, when 
installation is performed by a non-root user, a specific RPM database must be specified. The 
default RPM repository for non-root installation is set to ~/.rpmdb (where ~ is the user home 
directory). This directory can be overridden by specifying the –-rpmdbpath option as 
installation script argument. 

− The UCA Automation root directory must be read/write accessible by the non-root user. 
Usually the default /opt/UCA_Automation directory cannot be used (unless some specific 
rights have been set by the administrator). As a Consequence, when installation is performed 
by a non-root user, the –r option must be specified 

− When installed by the non-root users the UCA Automation scripts will only be executable by 
the user who performed the installation 

• The script installs the package under root directory specified by the user. The following 
directories are created. 

− bin 

− uninstall-uca-automation.sh 

− Licenses 

− Orchestration_Plugin 

− UCAAutomationOrchestrator.jar 

− TeMIP_Integration 

− TEMIPTFRLIN_00172.tar 

− TEMIPTFRLIN_00172.text 

− UCA_Automation_SetupLaunch.conf 

− UCA_Automation_ChannelAdapters 

− uca-autoconsole-ca-2.0.0-L.tar 

− uca-hpsa-ca-2.0.0-L.tar 

− UCA_Automation_UMBAdapters 

− hpe-service-activator-umb-adapter-1.0.0.tar 

− service-activator-umb-proto-1.0.0-javadoc.jar 

− service-activator-umb-proto-1.0.0.jar 

− UCA_Automation_HPSA_VPs 

− UCA_HPSA_DomainExample_VP-V21-1A.zip 

− UCA_HPSA_FoundationVP-V21-1A.zip 

− UCA_Automation_UCA_VPs 

− UCA_Automation_DomainExample_UCA_EV-vp-V2.1-1A.zip 

− UCA_Automation_Foundation_UCA-vp-V2.1-1A.zip 

− UCA_Automation_DomainExample_UCA_PD-vp-V2.1-1A.zip 
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− Utilities 

− Admin 

− DecisionTree 

− TomSawyerVisualization 

 

Table 3: RPM artifacts 

Artifact Description 
TEMIPTFRLIN_00172.tar TeMIP Server Patch – User Defined Attributes 
uca-autoconsole-ca-2.0.0-L.tar UCA-Automation Console Channel Adapter 
uca-hpsa-ca-2.0.0-L.tar UCA HPE SA Channel Adapter 
UCA_HPSA_DomainExample_VP-V21-1A.zip HPE SA example VP 
UCA_HPSA_FoundationVP-V21-1A.zip HPE SA Foundation VP 
UCA_Automation_DomainExample_UCA_EV-vp-V2.1-
1A.zip 

UCA EBC example evaluate value pack 

UCA_Automation_Foundation_UCA-vp-V2.1-1A.zip UCA EBC Foundation VP 
UCA_Automation_DomainExample_UCA_PD-vp-V2.1-
1A.zip 

UCA EBC example PD value pack 

hpe-service-activator-umb-adapter-1.0.0.tar UCA HPE SA UMB Adapter 

3. Verify if the package is installed successfully. 

a. Run the following command: 

# rpm -qa | grep -i Automation 
UCA_Automation-V2.1-REV_A.noarch 

b. Uninstall the packages by running the uninstall-uca-automation.sh provided in <UCA 
Automation root>/bin: 

When the uninstall-uca-automation.sh tool is launched, it checks for all UCA 
Automation packages installed on your system and prompts you for the number 
associated with the package to be uninstalled 

# /opt/UCA_Automation/bin/uninstall-uca-automation.sh  

You should get an output similar to the following text 

# here is the list of installed UCA Automation packages: 
 
        [0]     UCA_Automation-V2.1-REV_A.noarch 
 
Enter the index number of UCA Automation version to un-install ('Enter' to Cancel):  

By entering ‘0’ (as in the example above), UCA Automation version V2.1 will be removed 
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3.2 Installing HPE SA Foundation value pack 

3.2.1 Deploy HPE SA Foundation value pack 
The HPE SA foundation value pack is delivered as a ZIP file named UCA_HPSA_FoundationVP-
V21-1A.zip.  

• As a root user, copy the ZIP file of the foundation value pack from <UCA Automation 
root>/UCA_Automation_HPSA_VPs to the ${ACTIVATOR_OPT}/SolutionPacks 
directory. 

• Import and deploy the Foundation Value Pack solution.  

• Make sure that the Create Inventory Table checkbox is selected. 

• For information on undeploying and deleting the HPE SA solution pack, refer to the Solution 
Separation and the Deployment Manager. 

3.2.2 Configure HPE SA Foundation value pack 
• As a root user, run the config.sh script in the ${SOLUTION_ETC}/config directory.  

• The script enables the httpsender module in the mwfm.xml file of the HPE SA with the web 
service URL hosted in the HPE SA Channel Adapter. When the HTTPsender module is enabled, it 
sends the responses to the  Automation Console. 

 

# cd /opt/OV/ServiceActivator/solutions/UCA/etc/config 
# chmod +x ./config.sh 
# ./config.sh 
Setting up the Service Activator UCA Foundation Value Pack... 
 
Configuring MicroWorkFlow Manager (/etc/opt/OV/ServiceActivator/config/mwfm.xml)... 
=============================================================== 
 
UCA HTTP Sender module... 
Enter Host name/IP address of the web service hosted in HPSA Channel Adapter 
[localhost] :  
Enter port for web service hosted in HPSA Channel Adapter [ 8191 ] : 
8191 
(Saving mwfm.xml for future reconfiguration) 
 
/etc/opt/OV/ServiceActivator/config/mwfm.xml configured 
 
Done setting up Service Activator Foundation Value Pack 
 
Log file: 
/var/opt/OV/ServiceActivator/log/tfrsol1/ucasp.install.031813_013907.log 
 
Changes in Service Activator configuration files 
may be inspected in files: 
/var/opt/OV/ServiceActivator/log/tfrsol1/uca.mwfm.xml.diff 
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Press enter to continue... 

• The following is a snippet of the mwfm.xml file. 

 

• Reload the configuration from the HPE SA UI or restart HPE Service Activator. 

3.3 Installing UCA EBC Foundation value pack 
The UCA Automation foundation value pack is delivered as a ZIP file named 
UCA_Automation_Foundation_UCA-vp-V2.1-1A.zip. 

• Copy the ZIP file of the foundation value pack from <UCA Automation 
root>/UCA_Automation_UCA_VPs to the ${UCA_EBC_INSTANCES}/valuepacks 
directory. 

• Deploy the Foundation value pack. 

• For details, refer the UCA for Event Based Correlation Value Pack 
Development Guide. 

• Edit the ${UCA_EBC_DATA}/instances/default/conf/uca-ebc-log4j.xml file. 

• Add the following section in the file under the root tag <log4j:configuration>, specifically 
below the comment line Detailed Traces for Value Pack Scenarios: 

 

<logger name="UCA_Automation_Foundation_UCA.requestresponse" additivity="false"> 
<level value="TRACE" /> 

 <appender-ref ref="CONSOLE" /> 
 <appender-ref ref="FILE" /> 
</logger> 
 
<logger name="UCA_Automation_DomainExample_UCA_EV.evaluate" additivity="false"> 
 <level value="TRACE" /> 
 <appender-ref ref="CONSOLE" /> 
 <appender-ref ref="FILE" /> 
</logger> 
 
<logger name="com.hp.ucaautomation" additivity="false"> 
 <level value="TRACE" /> 
 <appender-ref ref="CONSOLE" /> 
 <appender-ref ref="FILE" /> 
 </logger> 
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• Copy the service-activator-umb-proto-1.0.0.jar from <UCA Automation 
root>/UCA_Automation_UMBAdapters (default is 
/opt/UCA_Automation/UCA_Automation_UMBAdapters) to 
${UCA_EBC_HOME}/lib 

• The following configuration in ExternalActionConfig.xml file available in the 
${UCA_EBC_INSTANCES}/deploy/UCA_Automation_Foundation_UCA-V2.1-
1A/conf directory is used internally by the value pack to clean completed actions. The value 
must not be modified 

<!-- Interval to clear executed Actions --> 
<executedActionsClearInterval>180000</executedActionsClearInterval> 

 

Restart UCA-EBC 

3.3.1 Configure UCA Automation UI 
• Edit the UCAAutomation.properties file in the 

${UCA_EBC_INSTANCES}/deploy/UCA_Automation_Foundation_UCA-V2.1-
1A/conf directory. 

• Update the <ipaddress> with UCA EBC Server host IP address. 

UCACONSOLE_CA_URL=http://<ipaddress>:26700/uca/mediation/action/ActionService?wsdl 
ucaebc_tomsawyer_port=http://<ipaddress>:8888/graphdisplay/?username=root&nodeId=0&profile=
ucaatm 

• Update the database.  

− If you have an enterprise database Postgres, use the following configuration. 

DB_DRIVER=org.postgresql.Driver 
DB_URL=jdbc:postgresql://<db-host>:<db-port>/<db> 
DB_USER=<db-user> 
DB_PASSWORD=<db-user-password> 

− If you have Oracle database, use the following configuration. 

DB_DRIVER=oracle.jdbc.driver.OracleDriver 
DB_URL=jdbc:oracle:thin:@<db-host>:<db-port>:<db> 
DB_USER=<db-user> 
DB_PASSWORD=<db-user-password> 

• If you have Oracle Real Application Clusters, configure the Database URL as shown below 

jdbc:oracle:thin:@(DESCRIPTION= 
   (LOAD_BALANCE=on|off)  
   (ADDRESS=(PROTOCOL=TCP)(HOST=db-host1)(PORT=db-port)) 
   (ADDRESS=(PROTOCOL=TCP)(HOST=db-host2)(PORT=db-port)) 
   (CONNECT_DATA=(SERVICE_NAME=service_name))) 

For more details look at the tnsentries in the tnsnames.ora 

• Edit the ExternalActionConfig.xml file available in the 
${UCA_EBC_INSTANCES}/deploy/UCA_Automation_Foundation_UCA-V2.1-
1A/conf directory and edit the following line with the UCA EBC server host name and port: 

<consoleurl> 
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http://localhost:8888/UCA_Automation_Foundation_UCA-V2.1-1A-UCAAutomation/UCAService 
</consoleurl> 

• If TeMIP is used as NMS, start the UCA_Automation_Foundation_UCA value pack.  

• If TeMIP is not the NMS, before starting the UCA_Automation_Foundation_UCA value pack, delete 
the mediation flow in UCA_Automation_Foundation_UCA value pack. 

 

Figure 1: Deleting the Mediation Flow from UCA_Automation_Foundation_UCA value pack 

3.3.2 Configure NOM 
In ValuePackConfiguration.xml , mediation flow is specified as follows. 

<mediationFlow name="temipFlow" actionReference="TeMIP_FlowManagement" 
flowNameKey="flowName" lastEventReceivedFirstDuringResynchronization="true">  
 <flowCreation> 
  <actionParameter> 
   <key>operation</key> 
   <value>CreateFlow</value> 
  </actionParameter> 
  <actionParameter> 
   <key>flowType</key> 
   <value>dynamic</value> 
  </actionParameter> 
  <actionParameter> 
   <key>operationContext</key> 
   <value>uca_pbalarm</value> 
  </actionParameter> 
 </flowCreation> 
 <flowDeletion> 
  <actionParameter> 
   <key>operation</key> 
   <value>DeleteFlow</value> 
  </actionParameter> 
  <actionParameter> 
   <key>flowType</key> 
   <value>dynamic</value> 
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  </actionParameter> 
 </flowDeletion> 
 <flowResynchronization> 
  <actionParameter> 
   <key>operation</key> 
   <value>ResynchFlow</value> 
  </actionParameter> 
  <actionParameter> 
   <key>flowType</key> 
   <value>dynamic</value> 
  </actionParameter> 
 </flowResynchronization> 
 <flowStatus> 
  <actionParameter> 
   <key>operation</key> 
   <value>StatusFlow</value> 
  </actionParameter> 
  <actionParameter> 
   <key>flowType</key> 
   <value>dynamic</value> 
  </actionParameter> 
 </flowStatus> 
</mediationFlow> 

 

In ExternalActionConfig.xml, action name and actionreference for NOM is specified as follows 

<action name="TeMIP EMS"> 
 <actionReference>TeMIP_AO_Directives_localhostNOM</actionReference> 
 <actionClass>com.hp.ucaautomation.action.framework.impl.TeMIPAction</actionClass> 
</action> 

In ExternalActionConfig.xml, the trouble ticket action name and action reference are specified as 
follows. 

<troubleTicketAction name=”TeMIP EMS"> 
 <actionReference>TeMIP_TT_Directives_localhostNOM</actionReference> 
… 
… 
</troubleTicketAction> 

 
In ExternalActionConfig.xml, the activation action name and action reference is specified as follows 

<activationAction name="HPSA"> 
 <actionReference>HPSA_diagnosticTask_localhost</actionReference> 

<actionClass>com.hp.ucaautomation.action.framework.impl.ServiceActivatorAction</actionCla
ss>  
</activationAction> 
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Please refer to Unified Correlation Analyzer for Event Based Correlation Value Pack Development 
Guide for more information on how to configure the ValuePackConfiguration.xml file if NMS is not 
TeMIP 

3.3.3 Configure UMB 
In ValuepackConfiguration.xml, UMB mediation flow for UMB is specified as follows. 

<mediationFlows> 
<UMBmediationFlow name="temipFlow" automaticStart="true" 

targetFlowName="UCAAutomationTeMIPFlow" targetAdapterName="TeMIP"> 
  <flowParameters> 
   <flowParameter value="uca_pbalarm" key="operationContext"/> 
  </flowParameters> 

</UMBmediationFlow> 
<UMBmediationFlow name="hpsaFlow" automaticStart="true" 

targetFlowName="synchResponseFlow" targetAdapterName="service-activator-umb-adapter">  
</UMBmediationFlow> 

</mediationFlows> 

In ExternalActionConfig.xml, the action name and actionreference for UMB are specified as follows 

<action name="TeMIP##UCAAutomationTeMIPFlow"> 
 <actionReference>TeMIP_AO_Directives_localhost</actionReference> 
 <actionClass>com.hp.ucaautomation.action.framework.impl.TeMIPAction</actionClass> 
</action> 

In ExternalActionConfig.xml, the trouble ticket action name and action reference are specified as 
follows. 

<troubleTicketAction name="TeMIP##UCAAutomationTeMIPFlow"> 
 <actionReference>TeMIP_TT_Directives_localhost</actionReference> 
… 
… 
</troubleTicketAction> 

 
In ExternalActionConfig.xml, the activation action name and action reference is specified as follows 

<activationAction name="HPSA"> 
 <actionReference>HPSA_diagnosticTask_localhost</actionReference> 

<actionClass>com.hp.ucaautomation.action.framework.impl.ServiceActivatorAction</actionCla
ss>  
</activationAction> 

 

Please refer to Unified Correlation Analyzer for Event Based Correlation Value Pack Development 
Guide for more information on how to configure the ValuePackConfiguration.xml file if NMS is not 
TeMIP 

3.4 Installing UCA Automation UI 
The UCA Automation UI is embedded in UCA Automation Foundation value pack and is delivered as 
a war file. 
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Deploy and start the UCA Automation Foundation value pack to view the UCA Automation UI. 

3.5 Install Custom attributes 

 
NOTE: This configuration is optional. Should be performed only if the NMS is TeMIP 

• To create custom attributes required for UCA Automation, refer to the instruction in the file 
${UCA_AUTO_HOME}/TeMIP_Integration/TEMIPTFRLIN_00172.text 

• Run the following command to update the TeMIP dictionary with custom attributes required for 
UCA Automation. 

/usr/opt/temip/bin/temip_ah_user_defined_attr -project TND 

• Run the following commands to reload the dictionary. 

# manage restart mcc 0 appli 631 
# manage reloaddict mcc 0 
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Chapter 4  
UCA Automation Orchestrator 

The UCA Automation 2.1 release provides an Eclipse plug-in to create and deploy UCA Automation 
Orchestrator. 

4.1 Prerequisites for installing Orchestrator 
Eclipse IDE for EE Developers Kepler version 4.3.2 

4.2 Install UCA Automation Orchestrator 

4.2.1 Install EMF plug-in 
• Download EMF plugin from the following url 

http://www.eclipse.org/downloads/download.php?file=/modeling/emf/e
mf/downloads/drops/2.10.0/R201405190339/emf-xsd-Update-2.10.0.zip 

• Open Eclipse. 

• Select Help -> Install New Software. Click on Add button and specify the path to the 
downloaded zip file in the “Location” field. 

 

Figure 2: Add EMF Repository 
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Figure 3: EMF components 

• Select All and click NEXT to install the software. 

 

4.2.2 Install GEF plug-in 
• Download EMF plugin from the following url 

http://www.eclipse.org/modeling/download.php?file=/tools/gef/downl
oads/drops/3.9.100/R201405261516/GEF-Update-3.9.100.zip 

• Open Eclipse. 

• Select Help -> Install New Software. Click on Add button and specify the path to the 
downloaded zip file in the “Location” field. 
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Figure 4: Add GEF Repository 

 

 

Figure 5: GEF components 

• Select All and click NEXT to install the software. 

 

 



 
UCA Automation Orchestrator 38 

4.2.3 Install Windows builder 
• Follow the instructions specified in the URL to install Windows builder 

http://download.eclipse.org/windowbuilder/WB/release/R201406251200
/4.3/ 

Drag the URL for this update site and drop it into the "Work with" field of the "Install" dialog 

 

Figure 6: Windows Builder components 

• Place the UCAAutomationOrchestrator.jar file in the dropins folder of the Eclipse.  

• Restart Eclipse. 

 

 
NOTE: If the UCAAutomationOrchestrator.jar file is updated, after placing the 
updated JAR file in the dropins folder of Eclipse, restart Eclipse with a -clean option 

• To verify whether the plug-in is installed, select Help -> About Eclipse -> Installation details -> 
Plugins.  

• The following Plug-ins tab in the Eclipse Installation Details window contains the plug-in name. 

http://download.eclipse.org/windowbuilder/WB/release/R201406251200/4.3/
http://download.eclipse.org/windowbuilder/WB/release/R201406251200/4.3/
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Figure 7: Installed PLug-ins 

4.3 Configure Orchestrator 
• After loading Eclipse, select Window -> Preferences -> General -> Workspace.  

• Select the checkbox for Refresh on access. 

 

Figure 8: Lightweight workspace refresh 
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• Configure the Active Provider in Eclipse to improve the upload performance of the decision tree.  

• Select Window -> Preferences -> General -> Network Connections.  

• Set the Active Provider to Direct. 

 

Figure 9: Network connection profile 
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Chapter 5  
UCA Automation Admin Tools 

5.1 Admin Tool 
Use the Admin tool to toggle the Protection Switch flag. The command-line tool is available under the 

${UCA_AUTOMATION_ROOT}/utilities/Admin/bin/uca-auto-admin directory. 

Table 4: Admin Utility options 

Options Description 
-h Displays command usage 
-ps 
<ON|OFF|check|reload> 

ON-  switches ON the Protection Switch flag 
OFF- switches OFF the Protection Switch flag 
check- displays the current status of the Protection Switch flag 
reload- resets the Protection Switch flag to the value present in the 
UCAAutomation.properties files. If this property is not found in the file 
then the Protection Switch is reset to OFF. 

 

5.2 Decision tree command line utility 
Use the Decision tree utility to upload a tree, delete existing tree/sub-tree from Neo4j graph 
database and to generate the skeleton decision from the UCA Automation RDBMS. 
The command-line tool is located in 
${UCA_AUTOMATION_ROOT}/utilities/DecisionTree/bin/decisionTree.sh 
directory. 

Table 5: Decision Tree Utility options 

Options Description 
-e <filename and path> Extracts data from RDBMS 
-u <filename and path> Uploads the decision tree. 
-d <service type name | 
ALL> 

Service type name : deletes all the children nodes and relationships of the 
service type node 
 
ALL or all : deletes the all nodes and relationship from the neo4j 
database 
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Edit the GraphDBUtilities.properties file available under the 
${UCA_AUTOMATION_ROOT}/utilities/DecisionTree/conf/ directory. 

#UCA Automation Inventory database connection details 
#Oracle jdbc driver : oracle.jdbc.driver.OracleDriver 
#Oracle url : jdbc:oracle:thin:@<hostname>:<port>:<service> 
#Postgres jdbc driver : org.postgresql.Driver 
#Postgres url : jdbc:postgresql://<hostname>:<port>/<service> 
inventory.db.driver= org.postgresql.Driver 
inventory.db.url= jdbc:postgresql://<hostname>:<port>/<service> 
inventory.db.user=<username> 
inventory.db.password=<password> 
 
#Neo4j database connection details 
neo4j.db.protocol=http 
neo4j.db.host=localhost 
neo4j.db.port=7474 
neo4j.db.db=db 
neo4j.db.data=data 
#enables batch transaction of inserts into neo4j db 
org.neo4j.rest.batch_transaction=true 
#enables http streaming 
org.neo4j.rest.stream=true 

 

Table 6: Decision Tree Utility configuration descriptors 

Properties Description 
inventory.db.driver Database driver name. 
inventory.db.url The connection URL. 
inventory.db.user The login user name of database. 
inventory.db.password The login password associated with the user name 
neo4j.db.protocol By default it is http. 
neo4j.db.host By default it is localhost. This is the hostname/IP address of the 

server where neo4j is hosted. 
neo4j.db.port By default it is 7474. The port number where neo4j is hosted. 
neo4j.db.db By default it is db 
neo4j.db.data By default it is data 
org.neo4j.rest.batch_transaction Enables batch transaction of inserts into neo4j 
org.neo4j.rest.stream Enables http streaming 
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Chapter 6  
Install NOM channel adapters 

6.1 HPE SA channel adapter 
To install and deploy the HPE SA Channel Adapter, follow the instructions in the UCA HPE SA CA 
Main Release Guide. 

Edit the config.properties file in the ${NOM_INSTANCE}/ips/uca-hpsa-ca-20/etc. 

 

# HPSA connectivity settings 
hpsa.host=0.0.0.0 
hpsa.port=<HPE SA port> 
hpsa.userid=<HPE SA user with StartJob privileges> 
hpsa.password=<password for the above HPE SA user> 
 
# UCA Automation controller workflow 
hpsa.controller.workflow.name=UCAController 
 
# UCA Automation response handler connectivity settings 
hpsa.uca-automation.sync-service.host=0.0.0.0 
hpsa.uca-automation.sync-service.port=8191 
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The following is a snippet of the config.properties: 

 

 

Table 7: HPE SA CA config descriptors 

Descriptor Description 

hpsa.host Hostname /IP address of the server where HPE SA is hosted.  

hpsa.port The listening port of  HPE SA  

hpsa.userid The login user name of HPE SA. The user has the permission to 
start and stop a job, as well as check the status. 

hpsa.password The login password associated with the user name 

hpsa.uca-automation.sync-
service.host 

The default value is 0.0.0.0. This is the hostname/IP address of 
the internal web service being hosted by HPE SA CA 

hpsa.uca-automation.sync-
service.port 

The default value is 8191. The listening port number of the internal 
web service hosted by CA. 

hpsa.controller.workflow.name The name of the HPE SA foundation workflow to be invoked in 
HPE SA. You cannot change the value. 

6.2 UCA Automation console channel adapter 
To install and deploy the Automation Console Channel Adapter, follow the instructions in the UCA 
Autoconsole CA Main Release Guide. 

Edit the config.properties file in the ${NOM_INSTANCE}/ips/uca-autoconsole-ca-
20/etc directory. 

 

uca.uca-automation.host=0.0.0.0 
uca.uca-automation.port=12500 
uca.console.service=UCA_Automation_Foundation_UCA-V2.1-1A-UCAAutomation/UCAService 
uca.console.host=localhost 
uca.console.port=<uca-ui.properties - ucaui.gui.port> 



 
Install NOM channel adapters 45 

The following snippet from the config.properties file contains sample values: 

 

Table 8: UCA Console CA config descriptors 

Descriptor Description 

uca.uca-automation.host Host name or the IP address of Automation console CA where 
the internal webservice is hosted. 

The default value is  0.0.0.0. 

uca.uca-automation.port Listening port of the internal Automation console CA web 
service. The default value is 12500. 

uca.console.service Name of the automation console web service. 

uca.console.host The Hostname /IP address of the server where the UCA 
Automation console is hosted. 

uca.console.port The listening port of the UCA Automation console.  

See section 6.2, uca-ui.properties - ucaui.gui.port  
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Chapter 7  
Install UMB adapters 

7.1 Service Activator UMB Adapter 
To install and deploy the Service Activator UMB Adapter, follow the instructions in Service 
Activator UMB Adapter 1.0.0 Installation and configuration guide. 

Edit the adapter.properties file in the ${SAUMB_INSTANCE}/conf/ directory. 

Replace “localhost” with the IP address of the the Kafka broker host. 

 

producer.metadata.broker.list=localhost:9092 
producer.request.required.acks=1 
 
consumer.zookeeper.connect=localhost:2181 
consumer.zookeeper.session.timeout.ms=6000 
consumer.zookeeper.sync.time.ms=203 
consumer.auto.commit.interval.ms=1000 
consumer.auto.offset.reset=smallest 

Table 9: Service Activator UMB Adapter config descriptors 

Descriptor Description 
 
producer.metadata.broker.list  
 

 
A list of Kafka broker <host>:<port> information. Set to 
localhost:9092 by default  

 
producer.request.required.acks  
 

 
Set to 1 by default, indicating that Kafka is in a mode 
where messages are acknowledged. This value 
controls when a producer request is considered 
completed. Specifically, how many other brokers must 
have committed the data to their log and 
acknowledged this to the leader 
0: means that the producer never waits for an 
acknowledgement from the broker. This option 
provides the lowest latency but the weakest durability 
guarantees (some data will be lost when a server fails). 
1: means that the producer gets an acknowledgement 
after the leader replica has received the data. This 
option provides better durability as the client waits 
until the server acknowledges the request as 
successful (only messages that were written to the 
now-dead leader but not yet replicated will be lost). 
-1: means that the producer gets an acknowledgement 
after all in-sync replicas have received the data. This 
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option provides the best durability, we guarantee that 
no messages will be lost as long as at least one in sync 
replica remains. 

 
consumer.zookeeper.connect 

 
List of ZooKeeper <host>:<port> information. Set to 
localhost:2181 by default  

consumer.zookeeper.session.timeout.ms  
Set to 6000 by default  
 

consumer.zookeeper.sync.time.ms  
Set to 203 by default  
 

consumer.auto.commit.interval.ms  
Set to 1000 by default  

consumer.auto.offset.reset  
Set to smallest by default. Indicates what to do when 
there is no initial offset in ZooKeeper or if an offset is 
out of range 
smallest: automatically reset the offset to the smallest 
offset 
largest: automatically reset the offset to the largest 
offset 
anything else: throw exception to the consumer 
 

Please refer to UMB Installation and configuration guide for more details on Adapter properties 

Edit the hazelcast.xml file in the ${SAUMB_INSTANCE}/conf/ directory. 

Replace localhost with the host IP address. 

 

<tcp-ip enabled="true"> 
                <interface>localhost</interface> 
<tcp-ip/> 

 
Edit the connection.properties in ${SAUMB_INSTANCE}/conf/ directory 
 

# Original version: 1.0.0 
 
# HPSA connectivity settings 
hpsa.host=0.0.0.0 
hpsa.port=8080 
hpsa.path=mwfmsoap/WFManagerService 
hpsa.userid=sa 
hpsa.password=sa 
 
# UCA-Automation controller workflow 
hpsa.controller.workflow.name=UCAController 
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# Parameters of synchResponse web service provided by this adapter. 
events.listen.host=0.0.0.0 
events.listen.port=8191 
events.listen.path=UCAAutomation/UCAService 
 

Table 10: Service Activator UMB Adapter connection properties 

Descriptor Description 

hpsa.host Hostname /IP address of the server where HPE SA is hosted.  

hpsa.port The listening port of  HPE SA  

hpsa.path The HPE SA web services interface  

hpsa.userid The login user name of HPE SA. The user has the permission 
to start and stop a job, as well as check the status. 

hpsa.password The login password associated with the user name 

events.listen.host The default value is 0.0.0.0. This is the hostname/IP address 
of the UCA Automation web service being hosted in HPE SA 
CA 

events.listen.port The default value is 8191. The listening port number of the 
UCA Automation web service hosted by CA. 

hpsa.controller.workflow.name The name of the HPE SA foundation workflow to be invoked 
in HPE SA. You cannot change the value. 

events.listen.path The UCA Automation web service interface 
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Chapter 8  
UCA Automation licensing 

A 60-day Instant-On license is installed by default when UCA-EBC Automation Foundation value 
pack is started. This license activates all features of the product for a trial period. After the expiration 
of the trial period, an extended evaluation or a commercial license is needed to continue using the 
product. 

For any questions related with licensing, please contact the UCA Automation product management 
team.  

8.1 Get a UCA Automation license 
You need a license key to use the UCA Automation software. Licensing is managed by AutoPassJ, 
which is automatically installed with UCA for EBC. You must obtain a license key to continue using 
the product after the 60-day trial period. 

The following is the process for getting a license key: 

• The system administrator of the product must go the HPE Licensing web site 
(http://enterpriselicense.hpe.com/redirector/home). 

• Download the perpetual license to use the product.  

• To request perpetual license keys, you should have the following information: 

− Entitlement Certificate—Contains the HP product number and order number (Entitlement 
order number). 

− Contact information of the license owner—Details of your company or organization. 

• (Optional) Contact the HP Password Center via fax, email, or phone.  

• For more information, refer to the Password Request Form and the License Entitlement 
Certificate. To get product licenses, you should have the License Entitlement Certificate. 

8.2 License policy 
When the UCA-EBC Automation Foundation Value Pack for EBC Server starts, the system runs a 
license check for UCA Automation feature. 

To activate this feature, you should have a valid license key. The UCA-EBC Automation Foundation 
value pack does not start if you do not have a valid license key for the UCA Automation feature. 
  

http://enterpriselicense.hpe.com/redirector/home
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The following table shows the link between UCA Automation product part numbers and the features: 

 

Product part 
number 

Description Enabled UCA Automation features 

JK461AAE HP UCA Automation 
Foundation Prod E-LTU 

HP UCA Automation Foundation Prod E-LTU 

HP OSS UCA Expert Production 

HP OSS UCA Expert DB 

HP Service Activator Tier X ELTU 

JK462AAE HP UCA Automation 
Foundation Non-Prod E-
LTU 

HP UCA Automation Foundation Non-Prod 
E-LTU 

HP OSS UCA Expert Production 

HP OSS UCA Expert DB 

HP Service Activator Tier X ELTU 

 

When you activate the UCA Automation Instant-On feature, UCA Automation automatically 
generates a corresponding license key which is added to the license.txt file available under the 
${UCA_EBC_DATA}/instances/<instance name>/licenses folder. By default the 
directory path is /var/opt/UCA-EBC/instances/default/licenses. 

This license.txt file contains all license keys. For information on installing the licenses, refer to 
the UCA-EBC and HPE Service Activator Installation Guides. 

8.3 Use Webware website for product licenses 
The following procedure discusses how to obtain your product licenses. 

• Go to HPE Licensing web site (http://enterpriselicense.hpe.com/redirector/home). Select the link 
for Hewlett Packard Enterprise Software Licenses and Downloads 

• The HP Passport Sign-in page appears. 

• Sign in using the user ID and password associated with your HP Passport.  

• If you do not have an HP Passport account, request for one by clicking the New users - Please 
register link. 

• Click Sign In. 

• The home page of the HP Licensing for Software web site opens. 

• Enter your entitlement order number in the Entitlement order number (EON) text box.  

• You order number is displayed on the License Entitlement Certificate (HP Order Number). 

• Click Go. 

• In the Entitlement column, select the checkboxes for the products for which you want license 
keys. 

• Click Activate. 

http://enterpriselicense.hpe.com/redirector/home
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• For each product you selected, enter the number of Licenses to Use (LTUs) in the Qty field.  

• The number of licenses is limited by the total number of LTUs available for the order.  

• For each product you selected, enter the required details in the Target field. 

• It includes the following: Server host name, IP address for the system where the software is 
installed, and so on. 

• Click Finish. 

• A confirmation message appears stating that an email containing the license keys has been sent 
to you. The page also displays the license keys and provides links for emailing and displaying 
them along with the information regarding the product activation. 

8.4 Install license keys for UCA Automation 
The following procedure discusses how to install license keys for UCA Automation. 

• After you get the UCA Automation license key, copy the license key to the license.txt file 
available under the ${UCA_EBC_DATA}/instances/<instance name>/licenses 
folder. 

• The default location is /var/opt/UCA-EBC/instances/default/licenses. 

• If you want to copy more than one license key to the license.txt file, append them to the 
license.txt file one after the other until all license keys are copied to the license.txt file. 

• Restart the UCA for EBC Server to apply the changes made to the license.txt file. 

8.5 Remove license keys for UCA Automation 
The following procedure discusses how to remove license keys for UCA Automation. 

• Remove the license keys from the license.txt file located in the 
${UCA_EBC_DATA}/instances/<instance name>/licenses folder. 

• The default location is /var/opt/UCA-EBC/instances/default/licenses. 
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Chapter 9  
Code signing 

This software product from HPE is digitally signed and accompanied by Gnu Privacy Guard (GnuPG) 
signatures. HPE strongly recommends using signature verification on its products, but there is no 
obligation. Customers have the choice of running this verification or not as per their IT Policies. 

9.1 Install and configure Gnu Privacy Guard (GnuGP) 
If you do not have GnuPG installed, you should download and install GnuPG. For information about 
obtaining and installing GnuPG, see http://www.gnupg.org 

Before verifying the signatures delivered on the HPE UCA Automation DVD, you should configure 
GnuGP for accepting the HPE signature. Use the following procedure to configure GnuGP: 

• Log into your system. 

• Get the HP public key from following location  

https://h20392.www2.hpe.com/portal/swdepot/displayProductInfo.do?productNumber=HPLinuxC
odeSigning 

• Download the compressed HPE GPG Public Keys from the location 
https://ftp.hp.com/pub/keys/HPE-GPG-Public-Keys.tar.gz. Save the keys in a folder viz. signcheck. 

• Uncompress and extract the file content. 

cd signcheck 
gunzip HPE-GPG-Public-Keys.tar.gz 
tar -xvf HPE-GPG-Public-Keys.tar 

• Import the public key 2BAF2262.pub into GnuPG by running the following command  

gpg --import 2BAF2262.pub 

• Configure the level of trust for the imported key 

gpg --edit-key 2BAF2262 
gpg (GnuPG) 2.0.14; Copyright (C) 2009 Free Software Foundation, Inc. 
This is free software: you are free to change and redistribute it. 
There is NO WARRANTY, to the extent permitted by law. 
 
 
pub  2048R/2BAF2262  created: 2015-12-10  expires: 2025-12-07  usage: SCEA 
                     trust: unknown       validity: unknown 
[ unknown] (1). Hewlett Packard Enterprise Company RSA-2048-14 <signhp@hpe.com> 
 
Command> trust 
pub  2048R/2BAF2262  created: 2015-12-10  expires: 2025-12-07  usage: SCEA 
                     trust: unknown       validity: unknown 
[ unknown] (1). Hewlett Packard Enterprise Company RSA-2048-14 <signhp@hpe.com> 
 
Please decide how far you trust this user to correctly verify other users' keys 

http://www.gnupg.org/
https://h20392.www2.hpe.com/portal/swdepot/displayProductInfo.do?productNumber=HPLinuxCodeSigning
https://h20392.www2.hpe.com/portal/swdepot/displayProductInfo.do?productNumber=HPLinuxCodeSigning
https://ftp.hp.com/pub/keys/HPE-GPG-Public-Keys.tar.gz


 
Code signing 53 

(by looking at passports, checking fingerprints from different sources, etc.) 
 
  1 = I don't know or won't say 
  2 = I do NOT trust 
  3 = I trust marginally 
  4 = I trust fully 
  5 = I trust ultimately 
  m = back to the main menu 
 
Your decision? 5 
Do you really want to set this key to ultimate trust? (y/N) y 
 
pub  2048R/2BAF2262  created: 2015-12-10  expires: 2025-12-07  usage: SCEA 
                     trust: ultimate      validity: unknown 
[ unknown] (1). Hewlett Packard Enterprise Company RSA-2048-14 <signhp@hpe.com> 
Please note that the shown key validity is not necessarily correct 
unless you restart the program. 
 
Command> quit 

9.2 Verify authenticity and integrity in RHEL  
This section explains the procedure to verify the signatures of the software packages to assess the 
integrity of the software before installation. 

In the command prompt, go to the home directory on the DVD and run the following command: 

gpg --verify uca-automation-kit-2.1-linux.tar.sig uca-automation-kit-2.1-linux.tar 

You should get the following output from the gpg command: 

gpg: Good signature from "Hewlett Packard Enterprise Company RSA-2048-14 <signhp@hpe.com>" 
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Appendix A  
Glossary 

Term Description 

UCA Unified Correlation Analyzer 

EBC Event Based Correlation 

IP Installation Package for OSS Open Mediation V7.2 

JDK Java Development Kit 

JMS Java Messaging Service 

JNDI Java Naming and Directory Interface 

JRE Java Runtime Environment 

Inference Engine Process that uses a Rete algorithm 

DRL Drools Rule file 

XML Extensible Markup Language 

XSD Schema of an XML file, describing its structure 

NOM NextGen OSS Open Mediation 

CA NOM Channel Adapter 

PPAS Postgres Plus Advanced Server 

UMB Unified Mediation Bus 

 

 


	Notices
	Preface
	About this guide
	Audience
	Software versions
	Typographical conventions
	Associated documents
	Support

	Chapter 1  Introduction
	1.1 Local install descriptors

	Chapter 2  System requirements
	2.1 Server platforms
	2.2 Hardware requirements
	2.3 Software requirements
	2.3.1 HPE UCA-EBC
	2.3.1.1  Configure HPE UCA EBC
	2.3.1.2 NOM Configuration
	2.3.1.3 UMB configuration

	2.3.2 HPE Service Activator
	2.3.3 NOM
	2.3.4 Configure TeMIP Channel Adapter for UCA Automation
	2.3.5 UMB
	2.3.6 UCA EBC UMB Adapter
	2.3.7 Configure TeMIP UMB Adapter
	2.3.8 JAVA
	2.3.9 Configure TeMIP 6.2L
	2.3.10 Configure TeMIP when used as NMS

	2.4 Web client

	Chapter 3  UCA Automation solution pack
	3.1 Installing UCA Automation solution
	3.2 Installing HPE SA Foundation value pack
	3.2.1 Deploy HPE SA Foundation value pack
	3.2.2 Configure HPE SA Foundation value pack

	3.3 Installing UCA EBC Foundation value pack
	3.3.1 Configure UCA Automation UI
	3.3.2 Configure NOM
	3.3.3 Configure UMB

	3.4 Installing UCA Automation UI
	3.5 Install Custom attributes

	Chapter 4  UCA Automation Orchestrator
	4.1 Prerequisites for installing Orchestrator
	4.2 Install UCA Automation Orchestrator
	4.2.1 Install EMF plug-in
	4.2.2 Install GEF plug-in
	4.2.3 Install Windows builder

	4.3 Configure Orchestrator

	Chapter 5  UCA Automation Admin Tools
	5.1 Admin Tool
	5.2 Decision tree command line utility

	Chapter 6  Install NOM channel adapters
	6.1 HPE SA channel adapter
	6.2 UCA Automation console channel adapter

	Chapter 7  Install UMB adapters
	7.1 Service Activator UMB Adapter

	Chapter 8  UCA Automation licensing
	8.1 Get a UCA Automation license
	8.2 License policy
	8.3 Use Webware website for product licenses
	8.4 Install license keys for UCA Automation
	8.5 Remove license keys for UCA Automation

	Chapter 9  Code signing
	9.1 Install and configure Gnu Privacy Guard (GnuGP)
	9.2 Verify authenticity and integrity in RHEL
	Appendix A  Glossary



